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游戏被很多人称为“第九艺术”，近年来更与传统的文学、音乐、建筑、雕

塑、绘画、舞蹈、电影和戏剧这“八大艺术”开始并驾齐驱。 

游戏之所以变得越来越受欢迎，我觉得与其丰富的体验方式和内容形式息

息相关。我们不仅可以在手机上畅游《原神》这样的二次元开放式大世界，也

可以在配备了高性能显卡的主机设备(如 Xbox 和 PlayStation)上，使用附带力反

馈功能的手柄体验与游戏世界中超写实类角色深入互动，更可以戴上 VR 头盔

感受真正的沉浸式3D 互动体验。 

而要做出好的游戏，游戏引擎是核心开发工具之一。Unity作为目前世界范

围内市场占有率第一的游戏引擎，经过十几年的快速发展，我们已经可以使用

它为将近 30 个计算平台开发互动式内容。无论你是开发 2D、3D，还是

VR/AR/MR 互动式内容，Unity都可以提供完整的开发工具链。近些年来，这些

内容已经超出游戏的领域，进入影视动画、汽车制造、建筑建造这些非游戏

领域。 

因为游戏本质上是实时渲染出来的互动式内容，所以游戏的一个基本功能

是可以接受玩家的输入信息(来自鼠标、键盘、手柄等)，并对其进行处理，然后

实时生成相关的内容。因此对于游戏开发人员来说，使用编程语言开发相关的

游戏逻辑就是其中必不可少的一环。 

本书使用通俗易懂的语言，深入浅出地为想要使用 Unity 开发互动式内容

(不仅仅是游戏)的读者，提供了非常系统性的学习资料。配合书中的实例项目，

一步一个脚印，按部就班地学习，相信大家很快可以掌握在Unity中使用C#编

程语言的基础知识，开始自己的游戏开发之旅！ 

 

 

杨栋 

Unity大中华区平台技术总监 

《创造高清3D 虚拟世界：Unity引擎HDRP 高清渲染管线实战》的作者
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随着新一代信息技术的日新月异，以数字化、网络化、智能化、虚拟化为

特征的信息化浪潮已经蔚然兴起，人们对信息内容的生产、传播和消费也从传

统的单一渠道、单一媒介、单一体验升级为对多元、多维、多态的全域融合媒

体的新需求。数字游戏融合了丰富的感官体验与高度的交互性，具有极佳的内

容叙事能力，已成为当前最受欢迎、最具影响力的数字内容表达与传播形式之

一；虚拟现实、增强现实、混合现实等人机交互技术更是为用户提供了虚实融

合、沉浸全息的极致体验，进一步拉近了用户与内容的距离；以“万物智联”“虚

实互映”为目标，数字孪生技术通过构建智慧工业、智慧城市、智慧校园等方

式，加快了政治、经济、生产、教育、文旅、传媒等各领域数字产业化和产业

数字化的进程 —— 而所有这一切，组成了今天备受人们关注和热议的元宇宙

领域的重要基石。 

与由短视频、自媒体的兴起会带来影视编辑学习门槛的降低，进而引领大

众学习并参与内容生产一样，数字内容的消费升级也亟需低门槛、高效率、开

放式的工具，使得万千大众能够积极参与数字内容的创作与开发，同时也为创

意工作者、独立开发者以及中大型工作室提供更便利、更强大、更丰富的创作

和开发环境，而Unity便是当前数字内容创作与开发领域中最受欢迎、最热门、

最广受好评的引擎之一。 

人工智能技术的快速发展与广泛应用，要求当代人应具备基本的编程能力

和算法思维，以培养面向未来智能社会所需的信息素养。C#语言作为一种面向

对象、类型安全、表达自然的编程语言，同时也作为 Unity 的脚本语言，是零

基础初学者学习编程的绝佳选择，也便于已具备C、C++、Java 和 JavaScript 经

验的成熟编程者快速上手Unity的脚本编写。 
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本书从学习者的角度出发，将以往同类教材中晦涩难懂的概念与日常生活

中的事物结合起来，用通俗平实的语言循序渐进地将编程的相关知识点娓娓道

来，并通过案例实践的方式，与学习者一起制作游戏来达到学习Unity的目的，

是一本适合各专业背景的学习者和数字内容创作爱好者学习与了解 Unity 游戏

开发与C#编程的入门教材和工具书。 

 

 

曹三省 教授 

中国传媒大学媒体融合与传播国家重点实验室党政班子成员 

协同创新中心副主任、互联网信息研究院副院长 

中国电子学会虚拟现实分会副主任委员 
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首先非常感谢两位老师为本书的翻译付出的辛劳，很荣幸我能够有机会提

前看到这本书，内容真的非常棒。本书充分地结合了Unity 来讲解C#的知识体

系。相比单纯的C#教学来说，更实用也更有意思！书中非常全面地介绍了Unity

游戏开发过程中大家几乎一定会用到的C#知识，并使用通俗易懂的方式来讲解

原理和实际运用。对于我个人来说，在我的Unity 项目中常常会运用很多C#内

容，但往往我只是停留在会用的程度，对其定义，或者说对其背后的基本原理

和概念缺乏透彻的理解。这本书能够帮助我更全面地了解这些内容。特别值得

一提的是，本书中的每一个关键知识点，除了结合了非常棒的案例以外，也有

很多需要特别“注意”的提醒！书中还包括很多C#技术文档的链接，可以帮助

想要更深入学习知识的朋友快速定位到需要查阅的内容。事实上，本书更像一

本参考书或字典，弥补了很多平时会被忽略的小技巧和知识点。想要在 Unity

开发过程中学习C#，看这本书就足够了！ 

当然，这本书除了C#语言的介绍讲解以外，也涵盖了对几乎所有Unity常

用主要功能的介绍，组件的使用方法等。如果全部认真看完并且自己动手完成

操作的话，那么你与做出一个小游戏Demo 就只差一套美术素材的距离了。 

总之，这本书让我收获很多。只有打好基础才能发挥更多创意。本书也是

我看过的唯一  一本讲解C#的书，推荐给所有刚刚上手Unity 或已经可以做一些

小Demo 的朋友来阅读学习，相信你一定会跟我一样收获良多。 

 

 

Michael Wang 

bilibili 知名UP 主：M_Studio 

2022 年度Unity最具社区影响人物 



 

 

推荐四 
 

 

 

 

社区里面经常会被问到：Unity学习过程中需要了解哪些知识？这是一个很

好的问题，也是一个很难回答的问题。幸运的是，本书很好地回答了这个问题。

本书从C#开始，涵盖Unity常用模块的使用，能够很好地帮助有兴趣的开发者

深入浅出、系统性地学习Unity。祝你开卷有益。 

 

 

Unity大中华区资深技术经理 

高川 
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从虚拟社区到游戏、元宇宙概念，虚拟体验实现了人们超越现实的想象，

而 3D 引擎是链接虚拟体验的重要工具。这是一本非常好的入门教材，当你有一

定的程序基础后，基于一个通用成熟的商业引擎，可以让你快速地了解3D 游戏

世界的基础结构搭建，从校门走向行业，将兴趣变成现实，帮助你完成自我的

学习和实践。国内关于游戏的书籍一直非常少，更多的内容仅存在于行业内的

交流。感谢分享经验和辛勤翻译的译者，让更多人有机会加入创造全新世界的

体验中来。 

 

 

徐振华 

苏州游戏蜗牛 九阴工作室负责人 
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游戏、互动式电影、扩展现实等一直深受青年一代的喜爱，尤其在当今全

面数字化的时代中，正逐渐成为文化创意、国际文化交流、文化遗产保护等众

多领域最重要的信息载体和有效传播手段之一。Unity 使用 C#作为脚本编程语

言，是青年人初次接触和尝试数字创意与开发的首选。本书条理清晰，语言表

达通俗易懂，真正面向零起点学习者，且对美术、艺术等非计算机相关专业背

景的读者也非常友好。通过对本书的学习，读者既能掌握 Unity 的基本使用和

操作技巧，同时也能掌握和理解C#编程基础以及通用的编程理论知识。  

 

 

王科 

大连外国语大学创新创业学院院长、 

软件学院院长、大数据产业学院院长 



 

 

贡献者 
 

 

关于作者 

Harrison Ferrone出生并成长于美国伊利诺伊州的芝加哥市。他曾工作于微

软、普华永道和一些小型的初创公司，但大多数日子里，他在为LinkedIn Learning 

和 Pluralsight 创建教学内容，或者为 Ray Wenderlich 网站进行技术编辑工作。 

他拥有来自科罗拉多大学博尔德分校和芝加哥哥伦比亚学院的多个看起来

很高级的文凭，尽管他是这些学校值得骄傲的校友，但这些文凭都被存放在某

个地下室里。 

在做了几年全职 iOS 和 Unity 开发者后，他投身于教学生涯，直至今日。

一路走来，他买过很多书，养过几只猫，也在国外工作过，并一直对于为什么

《神经漫游者》没有出现在更多课程的教学大纲上感到疑惑。 

本书的完成离不开来自 Kelsey的爱与支持，她是我的妻子，也是我一路走

来的伙伴。 

关于审稿人 

Simon Jackson是一名资深的软件工程师和架构师，他拥有多年的Unity游戏

开发经验，也是几本Unity游戏开发书籍的作者。他热爱创建Unity项目，同时也

乐于为学习者伸出援手，无论是通过博客、Vlog、用户小组还是大型演讲活动。 

他目前的主要工作是XRTK(混合现实工具包)项目，该项目旨在构建一个跨

平台的混合现实框架，以便VR 和AR 开发者能够在Unity中更高效地构建解决

方案，然后将它们构建和分发到尽可能多的平台上。 

向本书的试读者Kyle Quesada、Karen Stingel、Laksh M.及其他试读者表示

感谢，感谢你们花时间审阅本书的内容。你们的评论对我们的工作非常有帮助

和重要；在你们的帮助下，我们才能制作出尽可能高品质的书籍——一本贴近

目标受众且产生共鸣的书。真诚地感谢你们的参与，并期待能在未来再次合作！ 



 

 

译者序 
 

 

 

随着游戏、影视动画、扩展现实、数字孪生乃至元宇宙等相关技术与应用

的发展，世人对优质的视听、人机交互、虚拟仿真等相关需求愈加旺盛，数字

内容的种类与形式也越发广泛和丰富，越来越多来自不同领域与专业的创意人

员参与创作与开发。这便需要一种简单、快捷、高效的工具与工作流来满足不

同领域的内容创作者与开发者的需求，Unity便是其中最流行与优质并存的选

择之一。 
在Unity与C#教学过程中，我们发觉现有教材或教程大多延续了传统计算

机语言的语言范式和内容编排模式，虽严谨、专业度高，但言语晦涩难懂，更

与应用和现实生活脱节。尤其是对于艺术、动画等非工科背景的学习者来说，

专业语言成为一条难以逾越的门槛，很多 Unity 爱好者和学习者往往都因此中

道而止。而且，随着人工智能技术的发展，像 ChatGPT 这类的AI工具也悄然

影响着编程领域的学习，开发者可以通过自然语言直接生成C#代码，此时只需

要具备 C#基础知识，就可以快速判断 AI 生成代码的正确性，或者与 ChatGPT

反复推敲来调整代码，使之更适用于自己的项目。 
本书原著作者用极其通俗生活化的语言和比喻为读者诠释了Unity与C#语

言的基础知识与使用方法，并结合了项目实践、说明与提示、小测验等模块进

一步帮助读者理解和灵活运用C#与Unity。作者将创建的游戏项目命名为“Hero 

Born”(英雄诞生)，寄托了他对读者踏上学习征程的期许，还配有“Hero's Trial”

(英雄的试炼)环节，鼓励读者接受章节中的挑战。 
我们在翻译过程中也追求尽力还原和贴合原作者口语化的叙述风格，希望

能用平易近人的语言，为来自任意领域任何背景的读者清晰诠释相关专业概念。

期待本书可以成为帮助零基础，尤其是无编程背景的艺术、影视动画等学习者

了解Unity与C#的有利教程与工具书。 
 



 

 

 

 



 

 

前言 
 

 

 

Unity 是世界上最受欢迎的游戏引擎之一，它适用于业余爱好者、专业 3A

工作室和电影制作公司。尽管Unity常以其作为 3D 工具的使用而闻名，但它还

有诸多专有功能，为 2D 游戏、虚拟现实、影视后期制作、跨平台发布等内容

生产提供支持。 

开发者喜欢Unity的拖放界面和内置功能，但真正让Unity更上一层楼的，

是因其能为行为和游戏机制编写自定义 C#脚本。学习编写 C#代码对于已熟悉

其他语言、经验丰富的程序员来说可能不是一个巨大的障碍，但对于那些没有

编程经验的人来说，可能会是令人生畏的。本书的意义在，将带你从零开始学

习编程的和C#语言的基本知识，并同时在Unity中构建一个有趣且可玩的游戏

原型。 

本书读者对象 

本书主要面向没有编程基础或 C#语言经验的人群。然而，无论你是 C#语

言或其他编程语言的编程老手，还是编程初学者，只要想尝试在 Unity 中动手

实践进行游戏开发，那么本书就正是你所需要的。 

本书主要内容 

第 1 章“了解开发环境”，介绍了 Unity 安装过程、Unity 编辑器的主要功

能、如何查阅 C#和 Unity 特定主题的文档。以及如何从 Unity 编辑器创建 C#

脚本，并初步了解如何使用Visual Studio，Visual Studio 是进行所有的代码编辑

工作的地方。 

第 2 章“编程的基本构建块”，从列举编程的原子级概念开始，将变量、方

法和类与日常生活中的事物联系起来。然后，介绍了简单的调试技巧、如何进

行正确的格式设置和注释，以及Unity是如何将C#脚本转换为组件的。 

第 3 章“深入了解变量、类型和方法”，在第 2 章的基础上进行更深入的讲
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解，内容包括C#的数据类型、命名规则、访问修饰符等其他编程基础内容。还

介绍了如何更有效地编写方法、使用参数和返回类型。最后，对属于

MonoBehaviour类的标准Unity方法进行了概述。 

第 4 章“控制流和集合类型”，介绍了在代码中做决策的常用方法，包括

if-else和 switch 语句。然后介绍了如何使用数组、列表和字典，并结合迭代语句

来循环遍历集合类型。在本章的最后，介绍了条件循环语句和一个称为枚举的

特殊C#数据类型。 

第 5 章“使用类、结构体以及面向对象编程”，在本章首次接触如何构建和

实例化类和结构体。还介绍创建构造函数、添加变量和方法的基本步骤，以及

如何使用子类和继承的基础知识。最后，全面诠释了面向对象编程及其在C#中

的应用。 

第 6 章“亲手实践Unity”，标志着我们从C#语法进入游戏设计、关卡构建

和 Unity 特色工具的世界。首先从了解游戏设计文档的基础知识开始，然后进

行游戏关卡的几何布局，并添加光照和简单的粒子系统。 

第 7 章“角色移动、摄像机以及碰撞”，讲解了使玩家对象移动和设置第三

人称摄像机的不同方法，还介绍了如何通过 Unity 物理引擎获得更逼真的运动

效果，如何使用碰撞体组件以及如何捕获场景中的交互。 

第 8 章“游戏机制脚本编写”，介绍了游戏机制的概念以及如何有效地实现

游戏机制。从添加简单的跳跃动作开始，然后创建射击机制，并基于前几章的

代码添加处理道具收集的逻辑。 

第 9 章“AI 基础与敌人行为”，简要概述了游戏中的人工智能以及应用于

Hero Born 示例中的相关概念。涵盖的主题包括Unity中的地图导航、使用关卡

几何结构和导航网格、智能代理，以及敌人自动移动等。 

第 10 章“重睹类型、方法和类”，更深入地讲解了有关数据类型、中级的

方法特性以及可用于更复杂类的附加行为。本章带领读者进一步了解C#语言的

功能多样性和广度。 

第 11 章“特殊集合类型和LINQ”，深入探讨了栈、队列和哈希集，以及它

们分别适合的不同开发场景。此外，本章还探讨了如何使用 LINQ(语言集成查

询)对数据集合进行过滤、排序、变换等。 

第 12 章“保存、加载与数据序列化”，着重介绍了如何处理游戏信息。话

题涵盖了如何操作文件系统，以及如何创建、删除、更新文件等。此外还介绍

了如何处理如 XML、JSON、二进制数据等不同的数据类型，并在最后实践部

分讨论如何将C#对象直接序列化为对应的数据格式。 
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第 13 章“探索泛型、委托以及更多”，详细介绍了C#语言的中级特性以及

如何在实战中应用它们。从泛型编程的概述开始，逐步介绍了委托、事件和异

常处理等概念。 

第 14 章“旅程继续”，回顾了整本书中所学的主要主题，并提供了进一步

学习C#和Unity的资源。这些资源包括在线阅读材料、认证信息和一些推荐的

视频教程频道。 

如何充分地利用好本书 

为了能在即将到来的C#和Unity 旅程中获得最大收益，你唯一需要的是保

持好奇心和学习意愿。话虽如此，如果你希望巩固所学知识，那么完成所有的

代码练习、“英雄的试炼”和“小测验”等部分是必须的。最后，在继续学习新

知识之前，重温已学过的知识点或整个章节来刷新或巩固理解不失为一个好主

意。毕竟，在不稳定的地基上建造房子是没有意义的。 

此外，还需要在计算机上安装当前版本的 Unity——建议使用 2022 或更新

版本。所有代码示例均已在Unity 2022.1 上进行了测试，它们应该可以在未来的

版本中正常运行。 
 

本书涉及的软件和硬件 

Unity 2022.1 或更高版本 

Visual Studio 2019 或更高版本 

C# 8.0 或更高版本 
 

在开始之前，请参考以下链接，检查计算机设置是否满足Unity的系统要求：

https://docs.unity3d.com/2022.1/Documentation/Manual/system-requirements.html。 

本书的代码库和彩图可扫描封底二维码下载。 
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第1章 

了解开发环境 
 

 

流行文化喜欢将程序员描绘为局外人、独行侠或极客黑客，这些人拥有算

法思维的天赋，但缺乏社交和情商。虽然事实并非如此，但学习编程的确会从

根本上改变一个人看待世界的方式。好在出于好奇的天性，人类的头脑会很快

适应这种看待世界的新方式，甚至还可能会喜欢上这种新的思维方式。 

从清晨睁开眼睛的一霎那直至睡前望着吊扇的最后一瞥，我们都在不知不

觉中使用了可以直接转化为编程的分析技巧，只是缺乏正确的语言和语法将这

些生活技能映射为代码。例如，现实中每个人的年龄，可以看作编程中的变量；

再如，现实中我们习惯在过马路前观察道路两边，这相当于在编程中评估不同

的条件，专业术语称为控制流；又如，现实中看到一罐汽水，我们会本能地认

出它具有形状、重量和内容物等属性，这就好比编程中的一个类对象！以此类

推，这样的例子还有很多。 

有了这些真实世界的经验，你已经完全准备好进入编程的世界。为了更好

地开始旅程，还需要知道如何设置开发环境，如何使用涉及的应用程序，并确

切地知道该去哪里寻求帮助。 

为此，我们将从以下几个C#主题开始。 

● Unity 2022 入门 

● 在Unity中使用C# 

● 探索技术文档 

让我们开始吧！ 

1.1  技术要求 

有时候，使用反向排除胜过正向列举。本书的主要目标不是掌握 Unity 游



2 | Unity 和 C#游戏编程入门(第 7 版) 

 

戏引擎或游戏开发中的种种细节。但在旅程开始之前，有必要对 Unity 和游戏

开发有一个基础的认知，更多详情会在第 6 章中展开。这些主题会帮助我们以

一种有趣轻松的方式从零开始学习C#语言，但不是深入的Unity操作教程。因

为本书以编程作为主要目标，所以有时会更倾向于选择一个基于代码的解决方

案，即使 Unity 可能有一个特定的功能可以在不需要任何代码的情况下做同样

的事情。 

本书面向编程初学者，特别适合没有任何C#或Unity使用经验的读者！也

适合没有编程经验但对 Unity 编辑器有些了解的读者。此外，即便是对上述两

方面均有涉猎，但希望探索一些中高级主题的读者，也同样可以从本书的后几

个章节的相关内容中获益。 

如果已经熟练掌握其他编程语言，可略过初学者理论，直接跳至感兴趣的

部分。当然，也可选择从头学起，重温基础知识。 

学习中除了需要运行Unity 2022 以外，还将使用C# 8.0 和Visual Studio 来

编写游戏代码。 

1.2  Unity 2022 入门 

如果你还没有安装Unity，或者正在运行一个较早的版本，可按照以下步骤

设置你的环境。 

(1) 访问网址：https://unity.cn/。 

(2) 单击“下载Unity”按钮(如图 1-1 所示)。 

 
图1-1  Unity首页 
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(3) 这将跳转到Unity下载页面。不必惊慌，Unity可以完全免费使用！ 
 

说明： 

如果 Unity 首页看起来和截图中看到的不同，你可以直接进入 https:// 

unity.cn/releases。 
 

(4) 单击“下载Unity Hub”按钮(见图 1-2)。 

 
图1-2  下载Unity 

(5) 选择适合的系统下载Unity Hub 应用程序，如图 1-3 所示。尽管本书使

用的是Mac 系统，但几乎所有操作与在Windows 系统上是相同的。 

 
图1-3  下载Unity Hub 
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(6)下载完成后，按照以下步骤继续。 

① 打开安装包(双击它)。 

② 接受用户协议。 

③ 按照安装说明执行。 

(7) 安装成功后，启动Unity Hub 应用程序！ 

(8) 如果Unity提示选择许可证类型，请选择个人版许可类型(它是完全免费

的)，并根据指引设置你的账户。 

(9) 最新版的Unity Hub会鼓励安装最新的LTS(长期支持)版本的Unity编辑

器，如图 1-4 所示。但在撰写本书时 Unity 2022 仍处于预览版，因此如果在阅

读本教程时默认的版本是Unity 2022，请直接选择并单击 Install Unity Editor(安

装Unity编辑器)。 

 
图1-4  Install Unity Editor窗口 

(10) 如果此时你看到的默认版本并非 Unity 2022，请选择窗口右下角的跳

过安装(Skip Installation)，如图1-5 所示。 

 
图1-5  安装引导 
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(11) 从左侧列表中选择并切换到安装(Installs)标签，选择安装编辑器(Install 

Editor)，如图1-6 所示。 

 
图1-6  Unity Hub 的安装面板 

(12) 选择希望安装的Unity版本，然后单击 Install“安装”进行安装。在撰

写本书时，Unity 2022 还被列在 Official releases(正式发行版本)标签下的OTHER 

VERSIONS(其他版本)中，但也许在你阅读本书的时刻，应该已经可以在Official 

releases(正式发行版本)的列表中找到 2022 版本了(见图 1-7)。 

 
图1-7  在弹出窗口中添加Unity版本 

(13) 接下来将会有机会选择多种多样的模块并将其一同添加到安装过程

中。务必确保 Visual Studio 模块(Windows 或 Mac 版本)被选中，然后单击“继

续”(Continue)按钮，如图1-8 所示。 



6 | Unity 和 C#游戏编程入门(第 7 版) 

 

 
图1-8  添加要安装的模块 

(14) 如果之后任何时刻想要添加模块，可以在“安装”(Installs)窗口中单击

任何已安装Unity编辑器版本右侧的齿轮图标。 

当安装完成后，将会在“安装”(Installs)面板中看到新的版本，如图 1-9

所示。 

 
图1-9  “安装”面板与Unity版本 

 

说明： 

有关Unity Hub 应用程序的其他信息和资源可访问 https://docs.unity3d.com/ 

Manual/GettingStartedInstallingHub.html。 
 

有些出入是难免的，如果你使用的是 Mac OS Catalina 或更高版本的 Mac

系统，一定要查看接下来的内容。 
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1.2.1  使用 macOS 

如果你正在使用Catalina 或更高版本的Mac操作系统，那么使用Unity Hub

根据上述步骤安装 Unity 会存在已知问题。如果发生了这样的情况，没关系，

放轻松，可以进入Unity下载页面并获取所需版本(https://unity.cn/releases)。记住

使用“下载(Mac)”或“下载(Win)”选项而不是“从Hub 下载”选项进行下载，

如图 1-10 所示。 

 
图1-10  Unity下载页面 

 

说明： 

在应用程序安装包下载完毕后打开并根据安装指引进行安装。本书的所有

示例和屏幕截图都是使用 Unity 2022.1.13f1 版本创建和截取的。如果你正在使

用较新的版本，那么在 Unity 编辑器中的情况可能会略有不同，但这通常不会

影响后续的学习和操作。 
 

至此，Unity Hub 和Unity 2022 已经安装好了，是时候创建一个新项目了！ 

1.2.2  创建新项目 

启动Unity Hub 应用程序，我们将从这里“登场”。在这里可以查看所有项

目的列表和 Unity 版本，而且可以访问学习资源和社区功能等。接下来，请根

据下方的步骤操作。 

(1) 首先，单击右上角的“New project”选项，如图 1-11 所示。 
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图1-11  Unity Hub 的项目管理面板 

(2) 确保将位于顶端的编辑器版本设置为 2022 版本，并根据下方指引设置

相关字段区域。 

● 模板(Templates)：此项目将默认选择 3D 核心模板。 

● 项目名称(Project name)：将项目命名为“Hero Born”。 

● 位置(Location)：选择希望保存此项目的路径。 

(3) 当上述都设置完成后，单击“创建项目”(Create Project)。 

创建项目后，便可以开始探索 Unity 界面了！在任何时刻，我们都可以从

Unity Hub 的“项目”(Projects)面板重新打开项目，但如果感觉同时打开并

运行Unity和Unity Hub时计算机运行有点缓慢，则可以随时关闭Unity Hub(见

图 1-12)。 

 
图1-12  Unity Hub 中新项目设置的弹出窗口 
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1.2.3  编辑器界面导航 

新项目完成初始化后，将看到漂亮的Unity 编辑器界面！图 1-13 中对重要

的选项卡(也称面板)进行了标注。 

 
图1-13  Unity界面 

因为一口气记住所有面板需要花一点时间，所以先详细地介绍每个面板。 

(1)  Toolbar(工具栏)面板位于Unity编辑器的最顶部。在这里，可以登录Unity

账号、管理服务、与团队协作(最左边的按钮组)，以及运行和暂停游戏(位于中

央的几个按钮)。最右边的按钮组包含了搜索功能、图层遮罩和布局方案等功能，

但由于它们在学习C#的过程中不会被用到，因此我们在本书中将不会用到它们。 

(2)  Hierarchy(层级)面板显示了当前游戏场景中的每个物体。在新建的入门

项目中，这里默认只有摄像机和方向光。但是当我们创建原型环境时，此面板

将会被我们在场景中创建的物体对象填充。 

(3)  Game(游戏)和 Scene(场景)视图面板是编辑器最直观的区域。可以将场

景视图视为舞台，我们可以在其中移动和摆放 2D 和 3D 物体。当按下 Play(运

行)按钮时，将自动切换至游戏视图，在其中展示渲染后的场景视图和所有已编

程的交互。在按下Play按钮后仍然可以使用“场景”视图。 

(4)  Inspector(检视)面板是一站式查看和编辑所选对象属性的区域。例如，

当在Hierarchy中选中Main Camera(主摄像机)时(在图 1-13 中被蓝色高亮显示)，

该面板会显示它包含的几个“部分”，这些“部分”在Unity中称为组件，所有

组件都可以从此面板访问。 
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(5)  Project(项目)面板包含项目中当前存在的每个资产。可以将其视为项目

文件夹和文件的展示区域。 

(6) 在 Console(控制台)面板上，将显示我们希望脚本打印的任何输出。从

现在开始，如果我们提及控制台或调试输出，便到该面板查看相关结果。 

如果不小心关闭上述任一面板，则可以随时通过 Unity 菜单 > Window > 

General 再次打开它们。有关面板功能的深入解析可查看 Unity 文档：

https://docs.unity3d.com/Manual/UsingTheEditor.html。 

在继续之前，有必要明确 Visual Studio 已经被设置为项目的脚本编辑器。

通过 Unity 菜单选择 Edit > Preferences > External Tools，并检查 External Script 

Editor(外部脚本编辑器)是否已设置为 Visual Studio for Mac(或 for Windows)。见

图 1-14。 

 
图1-14  将External Script Editor(外部脚本编辑器)设置为Visual Studio 

小提示： 

如果希望在浅色模式(light mode)或深色模式(dark mode)之间切换，可以通

过 Unity菜单选择 Edit > Preferences > General 并改变 Editor Theme(编辑器主

题)来实现，如图 1-15 所示。 
 

 
图1-15  Unity的一般偏好设置面板 
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对于 Unity初学者，的确有很多东西要记忆和消化，但请放心，在后续的所

有内容中我们都会对必要步骤进行指引，避免使你犹豫不决或不知道该单击哪

个按钮。排除了这些顾虑之后，就让我们开始创建一些真正的C#脚本吧。 

1.3  在 Unity 中使用 C# 

从现在开始，很有必要将 Unity 和 C#视为相互共生的关系。在 Unity 引擎

中可以创建脚本和游戏对象(Game Objects)，但实际的编程却是在另一个名为

Visual Studio 的软件中进行的。 

1.3.1  使用 C#脚本 

尽管尚未介绍任何的基本编程概念，但作为基础中的基础，应该先知道如

何在 Unity 中创建实际的 C#脚本。C#脚本是一种特殊的 C#文件，在其中可以

编写C#代码。这些脚本可以被用于Unity以虚拟地实现任何事情，从通过键盘

控制游戏内角色到控制关卡中物体的动画等。 

从Unity编辑器中创建C#脚本的方法有以下几种。 

● 选择Assets > Create > C# Script。 

● 在Project 选项卡中，选择加号图标并选择C# Script。 

● 右击 Project 选项卡中的 Assets(资产)文件夹，然后在弹出菜单中选择

Create > C# Script。 

● 在 Hierarchy 窗口中选择一个 GameObject(游戏对象)，在 Inspector 中，

单击Add Component  > New Script。 

之后每当提到创建C#脚本时，请使用以上任何一种方法。 

也可以使用上述方法在编辑器中创建C#脚本以外的资源和对象。每当我们

创建新内容时，并不会明确指定使用这些方法中的哪一种变化形式，因此有必

要将这些方法的变化形式都熟练记住。 

为了便于组织和管理，通常习惯将各种资产和脚本存储在其对应名称的文

件夹中。这虽不是 Unity 要求的做法，但尽早养成好的习惯会受到同行的欢迎

和感谢。 

(1) 选择Assets > Create > Folder，并将其命名为Scripts，如图1-16 所示。 
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图1-16  创建一个C#脚本 

(2) 双击Scripts 文件夹并在其中创建一个新的C#脚本。默认情况下，该脚

本将被命名为 NewBehaviourScript，且文件名被高亮显示，此时可以立即对其进

行重命名。输入LearningCurve，然后按下键盘上的Enter 键。见图 1-17。 

 
图1-17  Project(项目)面板，当Scripts文件夹被选中时 

(3) 可以使用Project(项目)面板右下角的小滑杆来调节文件呈现的方式。 

我们刚刚创建了一个名为 Scripts 的子文件夹，如前面的屏幕截图所示。在

该文件夹内，我们创建了一个名为 LearningCurve.cs 的C#脚本(.cs 文件类型代表

C-Sharp，即 C#)，且已将其保存为项目 Hero Born 资产中的一部分。剩下要做

的就是在Visual Studio 中打开它！ 

1.3.2  介绍 Visual Studio 编辑器 

虽然在Unity中可以创建和存储C#脚本，但是需要使用Visual Studio 对其

进行编辑。Visual Studio 与Unity被预捆绑在一起，当从编辑器内部双击任何C#
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脚本时，将自动通过Visual Studio 打开。 

1. 打开C#文件 

首次打开文件时，Unity将与Visual Studio 同步。最简单的方法是从Projects

选项卡中选择脚本。具体步骤如下。 

(1) 双击C#脚本文件“LearningCurve.cs”，会在Visual Studio 中打开它，见

图 1-18。 

 
图1-18  在Visual Studio中打开的LearningCurve.cs脚本 

(2) 可以随时通过Visual Studio > View > Layout来改变Visual Studio的标签。

本书将使用Design 布局以便可以在编辑器的左侧看到项目文件目录。 

(3) 在 Visual Studio 界面的左侧会看到一个文件夹结构，该文件夹结构是

Unity中文件夹结构的镜像，可以用访问其他文件夹同样的方式访问它。右侧便

是生成一切魔法的代码编辑器。 Visual Studio 应用程序还有许多功能，但目前

这就是使程序运行所需要了解的全部内容。 

Visual Studio 的界面在Windows和Mac 环境中有所不同，但是本书中将使

用的代码在两种环境下均能很好地工作。本书中的所有屏幕截图均是在Mac环

境中截取的，因此，如果你在计算机上看到的外观有所不同，不必担心。 

2. 当心命名不匹配 

困扰编程新手的一个常见的陷阱是对文件命名。更准确地说，是命名不匹

配。我们可以使用之前Visual Studio 中C#文件的屏幕截图 1-18中代码的第5 行

来说明。 
 
public class LearningCurve : MonoBehaviour 
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LearningCurve 这个类名称与 LearningCurve.cs 文件名相同。这是一个基本要

求。如果你还不知道什么是类，那没关系。但要记住的重点是，在 Unity 中文

件名和类名必须相同。如果在 Unity 之外使用 C#，则文件名和类名并不必须

匹配。 

在Unity中创建C#脚本文件时，Project 面板中的文件名自动处于Edit(编辑)

模式，意味着已为重命名做好准备。因此，在此处重命名是一个好习惯。如果

稍后重命名脚本，则文件名和类名可能会不匹配。 

如果选择了稍后更改文件名，尽管文件名会发生改变，但此时第 5 行会变

成类似下方所示的样子。 
 
public class NewBehaviourScript : MonoBehaviour 
 

如果不小心这样操作了，也并不是什么末日灾难，所需要做的就是在Project

面板中右击该脚本并选择Rename(重命名)，见图1-19。 

 
图1-19  重命名C#脚本 

1.3.3  同步 C#文件 

作为它们共生关系的一部分，Unity和Visual Studio 彼此保持联系以同步其

内容。这意味着，如果在其中一个应用程序中添加、删除或更改脚本文件，则

另一个应用程序将自动接收到所做的更改。 

正如墨菲定律中说的“凡是可能出错的事，就一定会出错”，万无一失的事

物并不存在，那么当脚本没能正常同步时，会怎样呢？如果遇到这种情况，不
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必惊慌，选中那个出现麻烦的脚本，单击鼠标右键，然后选择 Refresh(刷新)，

如图 1-20 所示。 

 
图1-20  刷新C#脚本 

现在我们已经掌握了脚本创建的基础知识，该是讨论如何查找和更有效率

地使用帮助资源的时候了。 

1.4  浏览技术文档 

在对Unity与 C#脚本的首次尝试中，要涉及的最后一个话题是浏览技术文

档。这个话题并不吸引人，但在与新的编程语言或开发环境打交道前培养一个

良好的习惯很重要。 

1.4.1  访问 Unity 的技术文档 

一旦开始认真编写脚本，就会经常使用 Unity 的技术文档，因此尽早了解

如何访问它是有益的。参考手册(Reference Manual)为我们提供了某一组件或主

题的概述，而特定的编程示例可以在脚本参考(Scripting Reference)中找到。 

场景中的每个游戏对象 GameObject(Hierarchy 面板中的一个物体)都具有一

个控制其Position(位置)、Rotation(旋转)和Scale(缩放比例)的Transform(变换)组

件。为简单起见，我们将在参考手册中查看摄像机的Transform组件。 

(1) 在Hierarchy面板中，选中Main Camera(主摄像机)游戏对象。 
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(2) 将视线移至 Inspector 面板，单击 Transform 组件右边的信息图标(？)，

见图 1-21。 

 
图1-21 在 Inspector中选中Main Camera游戏对象 

(3) 网络浏览器会打开并显示参考手册中的Transforms 页面，见图1-22。 

 
图1-22  Unity的参考手册 

 

提示说明： 

Unity中的所有组件都具有此功能，因此，每当我们想进一步了解某件事情

的工作原理时，便可以用该方式查看。 
 

至此，我们已经打开了参考手册，但如果想要查看与Transform 组件相关的

具体代码示例，该怎么办呢？这很简单，所要做的就是查询脚本参考。 

(1) 单击组件或类名称(在本例中为 Transforms)下方的 SWICTH TO 
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SCRIPTING(切换到脚本)链接，见图1-23。 

 
图1-23  Unity参考手册，SWICTH TO SCRIPTING按钮高亮显示 

(2) 操作后，参考手册会自动切换到 Transform 组件的脚本参考页面，见

图 1-24。 

 
图1-24  Unity脚本参考文档，此时按钮变为SWITCH TO MANUAL 

(3) 可以看到，在必要时可以通过SWITCH TO MANUAL 选项切换回参考

手册。 

脚本参考是一个庞大的文档，因为需要囊括大量内容。但这并不意味着我

们必须记住或熟悉其所有内容才能开始编写脚本。如其名字所示，它只是一个

参考，而不是考试。 
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提示说明： 

如果发现自己迷失在文档中，或者不知从何处看起，还可以在 Unity 开发

社区中的以下位置找到丰富的解决方案。 

●   Unity Forum (https://forum.unity.com/) 

●   Unity Answers (https://answers.unity.com/index.html) 

●   Unity Discord (https://discord.com/invite/unity) 
 

另一方面，还需要知道在哪里可以找到可以解答任何C#问题的资源，我们

将在接下来的内容中进行介绍。 

1.4.2  查找 C#资源 

我们已经了解如何查看Unity资源，下面看一下Microsoft 的一些C#资源。

首先，位于 https://docs.microsoft.com/en-us/dotnet/csharp 的微软学习文档包含了

大量优秀的教程、快速开始指引以及指南文章。你也可以在下面这个地址找到

针对单独 C#话题的极佳概述：https://docs.microsoft.com/en-us/dotnet/csharp/ 

programming-guide/index。 

然而，如果想要了解某一特定C#语言功能的详细信息，参考指南可以派上

用场。这些参考指南对任何C#编程者而言都是非常重要的资源，但鉴于它们不

总是最易于定位的，因此这里让我们花一点时间学习如何找到我们想要的内容。 

打开编程指南链接并查找C#中的String类。可执行以下任一操作。 

● 在网页左上角的搜索栏中输入Strings。 

● 向下滚动至Language Sections，然后直接单击Strings 链接。见图 1-25。 

 
图1-25  在微软C#参考指南中定位 
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应该在类描述页面上看到类似以下页面的内容，如图 1-26 所示。 

 
图1-26  微软的Strings(C#编程指南)页面 

与 Unity 文档不同，C#参考文档和脚本示例信息全部整合在一起，但是幸

好有其右侧的子主题列表，应该充分地利用它！遇到困难或有疑问时，知道在

哪里寻求帮助是极其重要的，因此在遇到障碍时请务必重温本节。 

1.5  本章小结 

本章介绍了很多预备知识，想必你已经迫不及待地想要编写一些代码了。

在接下来令人兴奋的旅程中，如何新建一个项目、创建文件夹和脚本以及如何

访问技术文档常常容易被遗忘。只要记住，本章为接下来的学习提供了很多资

源，因此不要怕返回这里重新查看。编程思维如同肌肉记忆：训练得越多，就

会变得越强大。 

在第 2 章中，我们将开始为大脑铺垫编程所需的理论、词汇和主要概念。

我们会在 LearningCurve 脚本中编写第一行代码，尽管内容是概念性的。做好准

备吧！ 
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1.6  小测验 —— 关于脚本 

(1)  Unity和Visual Studio 之间存在怎样的关系？ 

(2) 脚本参考提供了有关使用特定Unity组件或功能的示例代码。在哪里可

以找到有关Unity组件的更详细(非代码相关)的信息？ 

(3) 脚本参考是一个大型文档。在尝试编写脚本之前你必须记住多少？ 

(4) 命名一个C#脚本的最佳时机是什么时候？ 

 

 



 

 

第2章 

编程的基本构建块 
 

 

 

任何一种编程语言对于不熟悉它们的人来说，起初看着都像外星文，C#也

不例外。但好消息是，潜藏在这些字符谜团之下，所有编程语言都由相同的基

本构建块构成。一般来说，变量、方法和类(或对象)构成了编程的 DNA；理解

这些简单的概念将为我们开启应用程序多样且复杂的世界。毕竟，尽管地球上

每人只有四种不同的DNA 核酸碱基，但它们却为每个人构成了独一无二的有机

生命体。 

如果你是编程新手，在本章中你将迎来许多新知识，这可能标志着你将编

写人生的第一行代码。本章并非试图通过事实和图表使你的大脑超载，而是希

望通过对照日常生活中的实例，为你提供一个了解编程基本构建块的全局视角。 

本章从高层次的视角审视构成一个程序的细枝末节。在直接开始写代码之

前先掌握其工作原理，不仅可以帮助编程新手找到立足之地，还可以通过易于

记忆的参考案例来巩固知识点。本章我们将聚焦在以下话题： 

● 定义变量 

● 了解方法 

● 了解类 

● 如何使用注释 

● 如何将各基本构建块整合在一起 

2.1  定义变量 

让我们从一个简单的问题开始：什么是变量？从不同的视角可以有以下几

种不同的方式回答该问题。 
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● 从概念上讲，变量是编程的最基本单位。一切都始于变量，没有变量，

程序就不可能存在。 

● 从技术上讲，变量是计算机内存中保存某一赋值的一块小区域。每个变

量都会跟踪其信息的存储位置(这称为内存地址)、值及其类型(例如数

字、字符或列表)。 

● 从实践应用上讲，变量是一个容器。我们可以随意创建新的变量，给它

们填入内容，移动它们，更改它们的内容并根据需要引用它们。它们甚

至可以是空的且依然有用处。 
 

提示说明： 

可以通过以下地址从微软的 C#文档中更深入地了解变量：https://docs. 

microsoft.com/en-us/dotnet/csharp/language-reference/language-specification/variables。 
 

变量的一个比较贴近真实生活的示例是信箱。你还记得它们吗(见图 2-1)？ 

 
图2-1  一排各种颜色的信箱 

信箱可以存放各种东西，比如信件、账单，或来自 Mabel 姨妈的照片。其

关键是邮箱中的东西可以是不同的：它们有一个名称且存放了信息(实体邮件)，

并且如果拥有正确的安全权限，甚至可以改变它们的内容。类似地，变量也可

以存放不同种类的信息。C#中的变量可以存放字符串(文本)、整型值(整数)以及

布尔值(二元值，“真”或“假”中的一个)。 

2.1.1  名字很重要 

参照图2-1，如果我要你打开信箱，你可能首先会问：打开哪一个？如果我

告诉你的是史密斯家的信箱或印有向日葵的信箱或最右边那个摇摇欲坠的信

箱，那么你便获得了打开我指定的信箱所必需的背景信息。相似地，在创建变
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量时，也必须给它们提供唯一的名称，以供之后指明时引用。我们将在第 3 章

中探讨命名的恰当格式和描述性命名的更多细节。 

2.1.2  变量充当占位符 

创建和命名变量时，其实是为要存储的值创建了一个占位符。以下面的简

单数学等式为例： 
 
2 + 9 = 11 
 

好吧，这很浅显易懂。但是如果希望把数字 9 换成一个变量，该怎么办？

思考以下代码： 
 
MyVariable = 9  
 

现在，便可以在任何需要的地方使用变量名MyVariable指代数值 9。 
 
2 + MyVariable = 11 
 

变量有其他规则或规定吗？答案是有。在第 3 章中将介绍这些内容，敬请

期待。 

上述示例虽不是真正的C#代码，却也体现了变量的能力以及将其视为占位

符并引用它的用法。接下来，我们将动手创建一个变量，让我们继续！ 

关于变量的理论已经足够，让我们在第 1 章创建的 LearningCurve 脚本中创

建一个真正的变量。 

(1) 在 Unity 中从 Project 面板找到并双击 LearningCurve.cs，以便在 Visual 

Studio 中将其打开。 

(2) 在第 6 行和第7 行之间添加一个空行，并参考下面的代码在该行中声明

一个新变量。 
 
public int CurrentAge = 30; 
 

(3) 在Start方法中，添加两条调试日志语句，以打印输出以下计算的结果。 
 
Debug.Log(30 + 1); 
Debug.Log(CurrentAge + 1); 
 

下面对上述添加的代码进行解构。首先创建了一个命名为 CurrentAge 的新

变量，并同时给它赋了一个值，为 30。然后，为了显示变量是如何作为值的

容器存储值的，我们添加了两条调试日志语句，用来将计算 30 + 1 与计算

CurrentAge + 1 的结果打印输出。可以发现，变量的使用方式与数值相同。 
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另外一个需要注意的重点是，public的变量会出现在Unity的 Inspector上，

然而 private 的变量却不会。目前暂时不需要担心语法，只需要确保你的脚本与

图 2-2 所示的脚本相同即可。 

 
图2-2 在Visual Studio中打开的LearningCurve 脚本 

最后，可以通过Editor > File > Save 命令保存文件，或用任何操作系统支持

的快捷键组合来保存文件。保存文件对于编辑脚本而言至关重要，因为对于脚

本的变更，只会在脚本文件保存后再切换回Unity编辑器时Unity才会识别脚本

的变化。如果在Visual Studio 中向一个脚本添加了新的代码，却没有保存的话，

Unity将不会识别。 

为了使脚本能在 Unity 中运行，必须将它们附着到场景中的 GameObjects

上。Unity将游戏中的任何事物都视为GameObject(游戏对象)，例如光源、玩家

角色、物品、建筑，一切的一切都是游戏对象。 

Hero Born 项目默认在初始仅有一个用于渲染场景的摄像机，以及一个方向

光，该光源为场景提供照明。简单起见，让我们将 LearningCurve 脚本附着到摄

像机上。 

(1) 将LearningCurve.cs脚本拖放到Main Camera上。见图 2-3。 

(2) 选中Main Camera，使其出现在 Inspector面板中，并查验是否已正确地

给主摄像机加上了LearningCurve.cs(Script)组件。 

(3) 单击Play按钮，并在Console(控制台)面板中查看输出。 
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图2-3  在Unity编辑器中拖曳并释放脚本 

此时你可能已经注意到，在游戏运行时编辑器界面变得略暗，且Play按钮

变为蓝色。这是因为Unity具有两种状态：编辑器状态和运行时(runtime)状态。

编辑脚本或向场景中添加物体时，应处于编辑器状态下。在此状态下，任何的

改变都将保存到项目中。然而，在按下了 Play 按钮之后，Unity 将切换到运行

时状态。在游戏运行时所做的任何修改都将不会保存，因此在此状态下需要额

外注意所做的更改。 

Debug.Log()语句会打印输出放在括号内的简单数学表达式的结果。如下面

的Console(控制台)屏幕截图(见图2-4)所示，使用变量CurrentAge的表达式与使

用数字的表达式结果相同。 

 
图2-4  在Unity控制台中显示所附脚本的调试输出 

在 2.5.1 节“将脚本变成组件”中，将介绍Unity是如何将C#脚本转换为组

件的，但是先让我们更改一个变量的值。 

如图 2-2 所示，由于CurrentAge 在第 7 行被声明为变量，因此其存储的值可

以在脚本内或在Unity的 Inspector中被更改(因为是 public变量)。更新后的值将
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至此向后被代码中任何使用该变量的地方沿用。让我们通过行动进一步了解。 

(1) 如果场景仍在运行，请通过单击Play按钮停止游戏。 

(2) 在 Inspector面板中将Current Age 更改为18，然后再次运行场景，并在

Console 面板中查看新输出，如图 2-5 所示。 

 
图2-5  在Unity的控制台中查看附加在主摄像机上的LearningCurve 脚本的调试信息 

第一个输出仍然是31，因为我们并没有对脚本做任何的修改。但是第二个

输出现在是19，因为我们在 Inspector中更改了变量CurrentAge的值。 

本节的目标不是要全面地介绍变量的语法，而是展示变量如何作为容器，

如何可以一次创建并在其他位置多次被引用。既然知道了如何在C#中创建变量

并为其分配值，就意味着已准备好深入下一个重要的编程基本构建块：方法！ 

2.2  了解方法 

只依赖变量自身，变量除了跟踪其分配的值之外并不能做太多的事情。尽

管这也很重要，但是就创建有意义的应用程序而言，单凭变量并不足够。那么，

如何在代码中创建动作和驱使行为呢？简单的回答就是要使用方法。 

在了解什么是方法以及如何使用它们之前，我们应该清楚一些术语。在编

程圈子里，特别是在 Unity 中，通常会看到“方法”和“函数”两种等价的

称呼。 

由于 C#是一种面向对象的语言(第 5 章中将涉及此部分内容)，本书其余部

分将使用“方法”这一称呼，以遵循标准的C#术语准则。 

当在脚本参考或任何其他文档中遇到“函数”这一称呼时，请将其视为“方法”。 

2.2.1  方法驱使行为 

与变量类似，给编程方法下定义可以是乏味且冗长的，也可以是异常简短

的，同样可以从以下三个层面去理解。 

● 从概念上讲，方法是应用程序内部各项业务运作的方式。 
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● 从技术上讲，方法是包含可执行语句的代码块，当方法名被调用时，这

些可执行语句便运行。方法还可以接受参数，参数仅在方法自身的作用

域内生效。 

● 从实践应用上讲，方法是每次被执行时都会运行的一组指令的容器。该

容器可以将变量作为输入，且只能在该方法本身内部被引用。 

综上所述，方法就如同程序的骨骼，它们将一切连接在一起，几乎所有内

容都基于方法的结构构建起来。 

可以在 Microsoft C# 文档 https://docs.microsoft.com/en-us/dotnet/csharp/ 

programming-guide/classes-and-structs/methods 中找到关于方法的深入指南。 

2.2.2  方法也是占位符 

让我们举一个简单的将两个数字相加的例子来全面理解方法的概念。编写

脚本，其本质上是在罗列一行行的代码，以便计算机按顺序执行它们。在第一

次需要将两个数相加时，可以像下面的代码块所示将它们相加。 
 
SomeNumber + AnotherNumber 
 

但是之后我们发现这些数字在其他地方也需要做同样的加法，加在一起。 

复制并粘贴相同的一行代码，会导致代码臃肿或产生称为“意大利面式”

的代码，应尽力避免此情形的发生。可以创建一个具有专属命名的方法来专门

执行此操作。 
 
AddNumbers () 
{  
  SomeNumber + AnotherNumber 
} 
 

这样，AddNumbers方法便在内存中占有一席之地，就如同一个变量。但是，

除了值之外，它还包含一个指令块。在脚本中的任何位置使用该方法的名称(称为

调用方法)，会让已被存储的指令唾手可得，而不必再重复编写任何相同的代码。 
 
AddNumbers() 
 

如果发现自己一遍又一遍地编写相同的代码，可能意味着你错失了将重复

的操作化简或凝练为通用方法的机会。 

这种情况通常被程序员戏称为“意大利面式”代码，因为这样的代码会变

得非常凌乱。程序员常提及一种称为“不要重复自己(DRY)”的原则来避免出现

这种情况，建议时刻牢记此原则。 
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和之前一样，在通过伪代码学习了新的概念后，最好是将其付诸实践，我

们在下一节中便会这么做来强化理解。 

让我们再次打开LearningCurve，看看方法是如何在C#中运作的。就像变量

的那个示例一样，请参照图 2-6 所示的代码一比一复制到脚本中。为了看起来

更整洁，其中已删除了上个示例的代码，但是你当然也可以将其保留在脚本中

以供参考。 

(1) 在Visual Studio 中打开LearningCurve。 

(2) 在第 8 行添加一个新的变量： 
 
public int addedAge = 1; 
 

(3) 在第 16 行添加一个新方法，将 currentAge 和 addedAge 相加，并打印出

结果。 
 
void ComputeAge() 
{ 
  Debug.Log(currentAge + addedAge); 
} 
 

(4) 在Start 内通过下面的代码调用新方法。 
 
void Start() 
{ 
  ComputeAge(); 
} 
 

(5) 在Unity中运行脚本之前，再次检查你的代码是否如图2-6 所示。 

 
图2-6  在LearningCurve脚本中创建ComputeAge方法 
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(6) 保存文件，然后返回Unity，单击Play按钮并在控制台中查看新的输出。 

我们在第16至19行中定义了第一个方法，并在第13行中对其进行了调用。

现在，无论在何处调用 ComputeAge()方法，两个变量都将相加并且相加的结果

会打印输出到控制台，即使它们的值发生了变化。请记住，我们之前在 Unity

的 Inspector中将CurrentAge设置为 18，而 Inspector中设置的值将总会优先覆盖

C#脚本中赋予的值(见图 2-7)。 

 
图2-7  在 Inspector中更改变量值并在控制台输出 

可以继续在 Inspector 面板中尝试不同的变量值，并查看结果！有关上面编

写代码的具体语法将在下一章讲解。 

现在已掌握了有关方法的知识，下面介绍编程领域中最大的知识点——类！ 

2.3  类 

虽然已经学习了变量如何存储信息以及方法如何执行动作，但是我们掌握

的编程工具箱依然很有限。我们还需要掌握一种方法来创建某种超级容器，它

拥有自身的变量和方法，且这些变量和方法可以通过该容器从其自身内部进行

调用。这便是类。 

● 从概念上讲，类将相关信息、动作和行为保存在单个容器中，它们之间

还可以相互通信。 

● 从技术上讲，类是一种数据结构。它可以包含变量、方法和其他程序信

息，这些信息皆可在该类的对象被创建后被引用。 

● 从实践上讲，类就像一个蓝图。它为任何参照该蓝图创建的对象(称为

实例)设定了规则和规定。 

可能你已发觉并意识到，不仅在 Unity 中，在现实世界中我们同样被各种

各样的类包围着。接下来，我们将审视一个最常见的 Unity 类以及现实生活中

的类是如何起作用的。 
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可以在 Microsoft C#文档 https://docs.microsoft.com/en-us/dotnet/csharp/

fundamentals/types/classes 中找到关于类的更深入的指南。 

2.3.1  一个常见的 Unity 类 

在知道C#中的类是什么样子之前，应该知道我们其实在本章中一直在使用

一个类。默认情况下，在 Unity 中创建的每个脚本都是一个类，这一点可以从

代码第5 行的 class关键字中看出来。 
 
public class LearningCurve: MonoBehaviour 
{ 
 
} 
 

MonoBehaviour代表该类可以附加到Unity场景中的GameObject上。两个大

括号标记了类的边界——括号内部的任何代码都属于该类。 

在C#中，类可以独立存在，这种用法我们将在第5章中创建独立的类时遇到。 

脚本和类的说法有时在Unity的一些资料中被交替使用。为了保持一致性，

在本书中，我们将附加到GameObjects 上的C#文件称为脚本。然而，如果它们

是独立的，我们则称其为类。 

2.3.2 类就像蓝图 

作为最后一个例子，让我们思考一下本地的邮局。邮局是一个独立且自包

含的环境，意味着邮局具有一些属性，比如物理地址(可以视为一个变量)；具有

执行业务的能力，比如可以发送信件(可以视为一个方法)。 

这便使邮局潜在地成为可用于描述类的一个很好的例子，可以通过下面的

伪代码块对其进行概述。 
 
public class PostOffice 
{ 
  // Variables 
  public string address = "1234 Letter Opener Dr." 
 
  // Methods 
  DeliverMail() {} 
  SendMail() {} 
} 
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这里值得关注的是，当信息和行为遵循某一预定义的蓝图时，复杂的动作

和类间的通信便成为可能。例如，如果有另一个类想要通过PostOffice类发送一

封信，它并不需要思考如何才能触发该操作，可以很简单地从PostOffice类中调

用SendMail方法来实现，如下所示。 
 
PostOffice().SendMail() 
 

另外，还可以用它查找邮局的地址，以便知道邮件是从哪里寄出的。 
 
PostOffice().Address 
 

也许你对上面英文单词间使用的英文句点(称为点表示法)存有疑惑，我们将

在下一节介绍它，请先跟上。 

2.3.3  类之间的通信 

到目前为止，我们将类以及作为其拓展的 Unity 组件都描述为分离的、独

立的个体。但实际上，它们之间是深深交织在一起的。如果类之间不存在交互

或通信，创建任何有价值的应用程序软件都将极其困难。 

在之前邮局的例子中，示例代码使用英文句点来引用类、变量和方法。如

果将类视为信息的目录，那么点表示法(dot notation)便是用来索引的工具。 
 
PostOffice.Address 
 

可以通过点表示法访问类中的任何变量、方法或其他数据类型。它同样适

用于嵌套的类或子类的信息，我们会在第 5 章涉及所有这些知识点。 

点表示法同样也是驱动类与类之间通信的手段。每当一个类需要有关另一

个类的信息或想要执行其中的方法时，都会通过点表示法来实现。 
 
PostOffice.DeliverMail() 

 

在某些文档中，点表示法有时也被称为“.”运算符(点运算符)。所以，如

果在某些文档中看到它以这种方式被提及，不要忘记它。 

如果尚未熟悉点表示法也不用担心，你一定会慢慢习惯它的。点表示法如

同流淌在整个程序躯干中的血液，在被需要的地方承载着信息和上下文。 

现在已对类有了稍多的了解，接下来谈谈在编程中使用最频繁的工具——

注释！ 
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2.4  使用注释 

你可能已经注意到，LearningCurve 脚本中有一行奇特的文本(图 2-6 中的

第 10 行)，这一行文本以两条斜线(正斜线/)开头，是创建脚本时默认生成的。 

它们是代码注释。在C#中，有多种方式创建注释，而Visual Studio(及其他

代码编辑应用程序)通常会通过内置的快捷方式使其变得更加容易。 

一些专业人士不会将注释视为编程的基本构建块，但我却无法认同这个观

点。用有意义的信息将代码进行恰当的注释，是编程新手最应培养的基本习惯

之一。 

2.4.1  单行注释 

下面的单行注释与在LearningCurve脚本中的注释相似。 
 
// This is a single-line comment 
 

Visual Studio 不会将以两条斜线(之间无空格)开头的行视为代码，因此我们

可以根据需要尽情使用它们为别人或为自己对代码进行诠释。 

2.4.2  多行注释 

正如其名，你大概也可以猜出单行注释仅适用于注释代码中的某一行。如

果要多行注释，则需要在注释文本前后使用斜线和星号的组合(即用/*和*/分别

作为注释的开始和结束字符)。 
 
/* this is a  
   multi-line comment */ 
 

还可以通过高亮显示代码块(拖动光标并选中代码块)并使用快捷方式来对

该代码块进行注释或取消注释。该快捷方式在MacOS 上为Cmd + /，在Windows

上为Ctrl + K + C。 

Visual Studio 还提供了一个方便的自动生成注释的功能。在任何代码行(变

量、方法、类等)之前的行中连续键入三条斜线，将出现一个摘要注释块，如

图 2-8 所示。 

示例中的注释看着再好，也不如在自己的代码中做好注释。开始习惯加注

释永远不会太早！ 
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2.4.3  添加注释 

打开LearningCurve，并在ComputeAge()方法上方添加三条斜线，见图 2-8。 

 
图2-8  为方法自动生成的三行注释 

此时应该看到三行注释，其中包含由 Visual Studio 根据方法名称生成的方

法的描述，夹在两个<summary>标签之间。当然，我们可以像在文本文档中一

样更改注释文本或按Enter 键添加新行，只要确保没有触及<summary>标签，否

则，Visual Studio 将无法正确识别注释。 

当想了解自己编写的某个方法时，这种详细注释就起到了作用。当某方法

使用了三条斜线进行注释，在任何调用该方法的位置，若将鼠标悬停在该方法

名称上，Visual Studio 会弹出显示该方法的注释摘要。见图 2-9。 

 
图2-9  Visual Studio弹出信息框以显示注释摘要 

至此，我们的基础编程工具箱已基本完备(至少是理论部分)。然而，我们仍

需要了解本章所学内容如何应用于 Unity 游戏引擎中，这将在下一节中重点

介绍！ 

2.5  整合基本构建块 

在本章收尾之前，随着各基本构建块的揭示，是时候做一些针对 Unity 的整

理工作了。具体来说，我们需要更多地了解Unity是如何处理附加到GameObjects

上的C#脚本的。 
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在本节的示例中，我们将继续使用LearningCurve脚本和Main Camera 这个

GameObject。 

2.5.1  将脚本变成组件 

所有GameObject的组件都是脚本，无论是由我们还是由Unity编写的。唯

一的区别是，对于由Unity提供的原生组件(例如Transform)及其对应的脚本，用

户通常不应该编辑它。 

一旦将创建的脚本拖放到某个GameObject上，它便成为该游戏对象的一个

新组件，这便是它会出现在 Inspector 面板中的原因。对于 Unity 而言，它同其

他任何组件一样能“走”、会“说”，并可随时在该组件下更改其公共变量。尽

管我们不应该编辑Unity提供的原生组件，但仍然可以访问它们的属性和方法，

从而使它们成为更强大的开发工具。 

当脚本成为组件时，Unity还会自动地进行一些可读性调整。你可能已经注

意到，当我们向 Main Camera 添加 LearningCurve 脚本时，如图 2-3 和图 2-5 所

示，在 Inspector 中，Unity 将其显示为“Learning Curve”，同时 CurrentAge 将其

显示为“Current Age”。 

在 2.1.2 节“变量充当占位符”中，我们已经尝试在 Inspector 面板中更新变

量值，现在有必要更详细地讲一下它的工作原理。调整某一属性的值可以分为

以下三种情况： 

● 在Unity Editor窗口的Play模式下(运行时状态) 

● 在Unity  Editor窗口的开发模式下(编辑器状态) 

● 在Visual Studio 代码编辑器中 

在Play模式下所做的更改会立即实时生效，这非常适合对游戏进行测试和

微调。但是，请务必注意，在停止游戏并返回到开发模式后，在Play模式下所

做的任何更改都将丢失。若丢失在Play模式下的更改会令人非常沮丧，所以请

务必留意游戏试玩测试时所处的模式。 

若要复制你在Play模式中所做的任何更改，请执行以下步骤。 

(1) 右击修改后的组件，选择Copy Component，如图2-10 所示。 
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图2-10 选择Copy Component 

(2) 退出Play模式，再次右击组件，这次选择Paste Component Values，如

图 2-11 所示。 

 
图2-11 选择Paste Component Values 

在“开发”模式下，对变量所做的任何更改都将由Unity保存。这意味着，

假设你退出Unity再重新启动它，更改仍将被保留。 

在 Inspector 面板中对值所做的任何更改都不会影响脚本中的内容，但是在

“运行”模式下，这些更改将覆盖在脚本中分配的值。 

在Play模式下所做的任何更改都将在停止Play模式时自动重置。如果需要

撤销在 Inspector面板中所做的任何更改，可以将脚本重置为其默认值(有时称为

初始值)。单击任何组件右侧的三个垂直点的图标，然后选择 Reset(重置)，如

图 2-12 所示。 
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图2-12  Inspector中的脚本重置选项 

如果变量失控了，我们总可以硬重置(hard reset)它们，这会让我们很安心。 

2.5.2  来自 MonoBehaviour 的助力 

由于 Unity 的 C#脚本都是类，那么 Unity 又是如何知道该把哪些脚本视为

组件，而哪些不视为组件呢？简单来说，LearningCurve(以及在Unity中创建的任

何脚本)继承自名称为MonoBehaviour的类(一个由Unity提供的默认类)。这便告

诉了 Unity，可以将这个 C#类转换为组件。然而，并非所有脚本都必须继承自

MonoBehaviour 类 ——只有那些想要添加到Unity 场景中的游戏对象上的脚本才

有必要继承。 

在我们编程旅程的当前阶段，介绍有关类的继承的知识点还略显有些超前。

我们暂可以认为 MonoBehaviour 类将其一部分变量和方法借给 LearningCurve 类

使用。在第 5 章中，将通过实践详细介绍类的继承，届时也将介绍如何编写一

个不继承自MonoBehaviour的类。 

常使用的 Start()和 Update()方法也都属于 MonoBehaviour 类，任何附加到

GameObject 的脚本中只要存在以上两个方法或其中任一个，Unity 都会自动运

行它们。在场景开始运行时，Start()方法会执行一次；而 Update()方法会每帧都

执行一次(因此执行频率取决于计算机的帧率)。 

既然我们对 Unity 文档的熟悉程度有了很大的提高，那么我们来尝试一个

简短的可选挑战！ 

英雄的试炼——脚本API中的MonoBehaviour 

现在是时候尝试独自使用 Unity 文档了，还有什么比查找一些常见的

MonoBehaviour方法更好的方式呢。 
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● 尝试在脚本 API 中搜索 Start()和 Update()方法，来更好地了解它们在

Unity中的作用。 

● 想挑战的话，还可以更进一步，查看手册中的MonoBehaviour 类，了解

更详细的解释和说明。 

2.6  本章小结 

了解基本概念(例如变量、方法和类)的理论将为我们打下坚实的基础。请记

住，这些基本构建块在现实世界中都可以找到非常真实的参照物。变量保管值，

如同信箱保管信件；方法如同配方，存储指令说明，以便我们遵循这些指令以

获得预期的结果；类就像蓝图，与真实的蓝图作用一样。 

如果你希望建造的房屋结实坚固，那么就不能没有一个经过深思熟虑的设

计方案来遵循。 

本书接下来将带你从零开始深入地学习C#语法，在第 3 章中将详细介绍如

何创建变量、管理数值类型以及使用一些或简单或复杂的方法。 

2.7  小测验——C#的基本构建块 

(1) 变量的主要目的是什么？ 

(2) 方法在脚本中起什么作用？ 

(3) 脚本是如何变成组件的？ 

(4) 点表示法的目的是什么？ 

不要忘记将你的回答与附录中提供的小测验答案做对照，以检验你的学习

成果。 
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